


Creating a
Chart

Charts (often called “graphs”) present information in a visual
fashion that usually has a much greater impact than numbers
displayed on a worksheet. In Excel, there are many different types
of charts that can be created from workbook information.

Creating a
Column Chart

You are going to create a chart from information in a workbook
named Sales Chart 1. Your first chart will be a column chart.

1. Open Sales Chart 1.

This worksheet shows the sales of three employees
for four separate quarters. You are going to chart the 
sales figures of ALLEN. The figures for each quarter
will appear in a vertical bar, making it easy to see
how the sales compare over the quarters for this
salesperson.

A chart has an X-axis (also called a category axis) and
a Y-axis (also called a value axis). The X-axis for this
chart will be along the bottom. On this axis will be
the categories – the quarters in B3:E3. The Y-axis for
this chart will be along the left side. On it will be a
scale for the sales figures in B4:E4.

2. The entire chart will display the information in A3:E4,
which you are going to select.

Select A3:E4.

3. A chart can be on the same worksheet as the data or
on a separate worksheet. This chart will be on a
separate worksheet. One of the quickest ways of
creating a chart on a separate worksheet is to tap the
CREATE CHART key (F11).

Tap the CREATE CHART key (F11).
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A chart appears on a new worksheet. Notice the
following:

! There are now two sheets for the Sales Chart 1
workbook — Chart1 and SALES. The active
sheet is Chart1, which is a chart sheet.

! The X-axis (at the bottom) consists of categories, 
which for this chart are the quarters.

! The Y-axis (at the left) is scaled. Excel chose an
appropriate scale for the Y-axis based on the
sales figures. The scale starts at zero and
increases in increments of 500.

! Each column represents the sales figures for the
indicated quarter. The columns are called data
points.

! The Legend box displays the color of the column
and its name. The name was taken from the first 
column of the selected range.

! The Chart toolbar will be located wherever it
was when it was last used. You will see this
whenever a chart sheet is created, and it will
stay with the chart sheet until you turn it off.

! There is an extra menu on the Menu bar called
Chart. This appears when the active worksheet
has a chart. You will be using it shortly.
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As a whole, the ALLEN sales figures are one data series. (As
mentioned, each quarterly sales figure for ALLEN is a data point.)
You are going to create a new chart with two data series — the
sales figures for ALLEN and those for BURTON.

1. Click the SALES sheet tab.

2. Select A3:E5.

You have selected two data series (rows 4 and 5).
Excel assumes that the quarters in row 3 are to be
the categories on the X-axis.

3. Tap the CREATE CHART key (F11).

Notice the new chart with columns representing two 
data series. Also notice that the Y-axis (or value axis)
has changed to accommodate the new data series.
The scale is now in increments of 1,000. There are
now two names in the Legend box. Notice that the
workbook now consists of three sheets. (Excel did
not include a title because there are now two data
series represented. You will learn to include titles in
a later lesson.)

Note: When you use the F11 key to cre ate a chart on
a new worksheet, the worksheet is al ways in serted
be fore the ac tive worksheet.
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Adding Data
to the Chart

You are going to add a third data series to this chart. A quick way
of doing this is to copy the new information, make the chart sheet
active, and then paste. Excel will assume that the contents of the
Clipboard is a new data series.

1. Click the SALES sheet tab.

2. Select A6:E6 (the CARLSON data se ries).

3. On the Edit menu, choose Copy.

A flashing marquee should be around the range.

4. Click the Chart2 sheet tab.

5. On the Edit menu, choose Paste.

Notice the new columns. Excel has pasted the
contents of the Clipboard into the chart as a new
data series. The chart now consists of three data
series. Each data series has four data points.

Changing
Data

You are going to change the data in the SALES sheet and watch the
chart change accordingly. Even though the chart is a separate
worksheet, it is linked to the SALES worksheet.

1. Click the SALES sheet tab.

2. Change ALLEN to SMITH.

3. Change the column B (Quarter 1) figures to 1000,
1500, and 7500.

4. Click the Chart2 sheet tab.
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Notice the new data points in the Quarter 1
category, and notice that the scale on the Y-axis has
changed. The highest number is now 8000. Also
notice SMITH in the Legend box.

5. You are going to change back to the original data.

Click the SALES sheet tab.

6. Change SMITH to ALLEN.

7. Change the column B figures to 2000, 5000, and
3000.

8. Click the Chart2 sheet tab.

Notice that the original data points in the Quarter 1
category have been restored and that the Y-axis has
changed accordingly.

Printing a
Chart

You can print a chart just as you would any other sheet. On the
Page Setup dialog box, however, there are some specific options
relating to charts.

1. Chart2 should be the ac tive sheet.

2. On the File menu, choose Page Setup.

3. Click the Chart tab.

Here are descriptions of the options on the tab:

Use full page. Fills the entire page with the chart,
even if it has to distort the chart’s proportions. This
is the default.
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Scale to fit page. Prints the chart as large as possible
without distorting its proportions.

Custom. Prints the chart the same size as it appears
on the screen.

Draft quality. This is useful when there is limited
printing memory. It lets you print faster, but the
print quality is not the the highest standard.

Print in black and white. Prints the chart with a
different (black and white) pattern for each data
series, instead of a different color (or, in the case of a 
printer that only prints black, shades of gray).

4. Click Cancel or print the chart, if you wish.

Tip: The best way to change the way your chart fits
on a page is to click the Print Pre view but ton, and
then on the Print Pre view toolbar click the Mar gins
but ton. Drag the mar gins to ad just the po si tion and
size of the chart. (See p.161 for more on Print
Pre view.)

Chart Types As you know, your present chart is a column chart. Excel lets you
use other chart types, such as bar, line, and pie charts. You are going 
to change your chart to other chart types.

1. Verify that Chart2 is the ac tive worksheet.
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2. As mentioned earlier, when the active worksheet
contains a chart, the Chart menu appears on the Menu
bar. When you go to a worksheet that does not have a
chart, the Chart menu disappears.

Click the Chart menu.

3. Choose Chart Type.

The Chart Type dialog box appears. 

4. Click the Standard Types tab.

On the left, notice the Chart type box. Column is
currently chosen because Chart2 uses this type of
chart. On the right is the Chart sub-type box. Notice
the different subtypes of Column charts.

5. On the Chart type list, choose Bar.

On the right, notice the different types of Bar charts.

6. On the Chart type list, choose Col umn so its
sub types are dis played once again. You will be
ex plor ing most of these types.

212 Microsoft Excel 2003 - Beginning and Beyond



Column
Charts

Excel provides subtypes for most chart types. For example, as you
have just seen, there are seven different column subtypes.

1. Verify that Col umn is cho sen in the Chart type list
box.

Notice the seven subtypes of column charts. The
first subtype is the default, which your chart is
using. Notice the description of the subtype at the
bottom — Clustered column. Compares values across
categories.

2. Below the description, hold down the button
named Press and Hold to View Sam ple.

Notice the sample of this subtype using the current
data.

3. Release.

4. The second subtype is a stacked column chart.

Click the second subtype.

5. Hold down the Press and Hold to View Sam ple
but ton.

Notice the sample.

6. Release.

7. Click OK to return to Chart2.

Notice the chart. This could be useful to show total
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sales for each quarter and the portion earned by
each employee.

8. On the Chart menu, choose Chart Type.

9. The third subtype displays the data as percentages. It is
a 100% stacked column chart, sometimes called a
percentage chart.

Click the third subtype.

Notice the description at the bottom.

10. Hold down the Press and Hold to View Sam ple but ton 
and no tice the sam ple.

11. Release and click OK to return to Chart2.

Notice that the Y-axis has percentages instead of
dollar amounts. You can see each salesperson’s
percent of the total for each quarter.
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12. Click the Chart menu and choose Chart Type.

13. In the Chart sub-type box, the three charts on the
second line are the 3-D counterparts of the 2-D charts
above them.

Click the first subtype on the second line and click
OK.

Notice the 3-D column chart. Except for the
three-dimensional look, there is no difference
between this chart and the standard column chart,
which is the first sub-type.

14. Click the Chart menu and choose Chart Type.

15. Choose the next two 3-D subtypes. Read their
descriptions, hold down the Press and Hold to View
Sam ple but ton, and re turn to the Chart2 sheet to
view them.

16. The seventh and last subtype of the Column chart does
not have a 2-D counterpart. It is a 3-D column chart
with a third axis. Each data series is in its own area or
plane.

If the Chart Type dialog box is not displayed, click
the Chart menu and choose Chart Type.

17. Select the last subtype, and click OK.

Notice that each data series is in its own plane. Also
notice that there is a third axis with the names of the 
data series, which are also in the Legend box. (You
would probably want to delete the Legend box for a
chart such as this.)
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Bar Charts Bar charts are the same as column charts except that the bars are
horizontal rather than vertical. The X and Y axes are reversed.

1. On the Chart menu, choose Chart Type.

2. Verify that the Standard Types tab is chosen.

3. In the Chart type box, click Bar.

The six Bar subtypes are the same types as the
Column charts — Clustered Bar, Stacked Bar, and
100% Stacked Bar. (The seventh is not available for
Bar charts.) As with Column charts, the types in the
second row are the 3-D counterparts of the 2-D types 
in the first row.

4. Spend some time previewing the subtypes by
holding down the Press and Hold to View Sam ple
but ton, and re turn ing to the Chart2 sheet to view
them. 
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Notice that the X and Y axes have switched
positions. Following is an example of the first
subtype. Notice the X and Y axes.

5. When finished, return to Chart2, if you are not on
it.

Line Charts A line chart displays a line for each data series (in this case, a
salesperson). The data points are little boxes on the line.

1. On the Chart menu, choose Chart Type.

2. In the Chart type box, choose Line.

In the Chart sub-type box, notice that the types on the 
second line have little boxes representing the data
points. The first type of this group is the default.

Verify that the first subtype on the second line is
selected.
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3. Hold down the Press and Hold to View Sam ple
but ton.

Notice the sample line chart. 

4. To get a better look at the chart, click OK to return
to the Chart2 sheet.

The quarterly trend of each salesperson is more
visually apparent. Notice the little boxes
representing the data points. For example, you can
see clearly that ALLEN’s figures (in blue) start at
2,000, rise to 2,200, dip to 1,700 and return in the 4th
quarter to 2,000.

5. Click the Chart menu, and choose Chart Type.

6. In the second row of the subtypes, click the second 
subtype.

This is a stacked line chart. Charts such as these are
more frequently used with statistical data.

7. Hold down the Press and Hold to View Sam ple but ton 
to view the sam ple.

8. Click the third subtype.

This is a 100% stacked line chart used to view
percentages.

9. Hold down the Press and Hold to View Sam ple but ton 
to view the sam ple.

10. The subtypes on the first row correspond to those in
the second row below them. They do not show the
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data points, however, because they are used when
trends are to be shown, rather than specifics. You might 
use these if you had a very large number of data points.

Spend a little time exploring the three subtypes in
the first row.

11. The last subtype is a 3-D line chart, the only 3-D line
chart that Excel provides.

Click it and then click OK to return to the Chart2
sheet.

Notice that each line becomes a ribbon in a separate
plane. There is a third axis with the names of the
data points, which are also in the Legend box.

Pie Charts Pie charts show only one data series, even if others exist.

1. On the Chart menu, choose Chart Type.

2. In the Chart type box, choose Pie.

Notice the subtypes on the right. Excel is using the
first data series for each chart.

3. With the first subtype selected, hold down the
Press and Hold to View Sam ple but ton.
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Notice that because only one data series is being
charted, Excel provides a title — Allen.

Following is a brief description for each type:

! The second type is a 3-D pie chart.

! The third type takes one slice and further
defines it in a second pie chart.

! The types on the second row correspond to
those on the first row. The first two “explode”
slices. That is, they separate the slices from the
rest of the pie. The first one is a standard pie
chart, the second one has a 3-D effect.

! The last type corresponds to the one above it,
except that it creates a bar chart rather than a
second pie chart.

4. Spend some time exploring these pie charts.

Following is an example of the second subtype,
which is a 3-D pie chart.

Tip: When a pie chart is cre ated, Ex cel uses the first
se ries in the plot or der. To plot an other data se ries,
se lect the la bels and the data se ries and cre ate a new
chart. For ex am ple, to cre ate a pie chart with the
CARLSON fig ures, se lect A3:E3 and A6:E6 (use the
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CTRL key while se lect ing), cre ate a new chart,
choose Pie and then choose the type.

Note: We are go ing to skip XY (Scat ter) charts for
the mo ment. It will be cov ered shortly.

Area Charts Area charts are line charts with the area below the lines filled in.
Line charts are good at communicating the rate of change in the
data. Area charts are good at communicating the magnitude of
change in the data.

1. On the Chart menu, choose Chart Type.

2. In the Chart type box, choose Area.

3. In the Chart sub-type box, notice that the second
subtype is the default.

Hold down the Press and Hold to View Sam ple
but ton.

Notice the area chart. This is the same as a stacked
line chart, with the areas below the lines filled in.

4. Click OK to return to the worksheet and notice the
chart at full size.

5. On the Chart menu, choose Chart type.

6. Click the first subtype.

Lesson 16 - Creating Charts 221



This is similar to a simple line chart, with the areas
below the lines filled in.

7. Click the third subtype.

This is similar to a percentage line chart (i.e., 100%
stacked line chart), with the areas below the lines
filled in. In fact the first three charts here are the
same as the first three for Line charts. The only
difference is that the areas below the lines have been 
filled in.

8. The first subtype on the second line is a simple area
chart with each data series in its own plane.

Select it and then click OK to get a good look at it.

Notice the 3-D effect with each data series in a
separate pane. Notice the extra axis with Carlson,
Burton, and Allen on it.

9. On the Chart menu, choose Chart Type.

10. The second and third types on the second line are 3-D
counterparts of those above them — the second is a
stacked area chart and the third a 100% stacked area
chart.

Explore these two types by reading the
descriptions, clicking the Press and Hold to View
Sam ple but ton, and re turn ing to Chart2 to get a
better look.
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Doughnut
Charts

In Doughnut charts, each data series is a circle. Doughnut charts are
similar to pie charts except that they can chart more than one data
series.

1. If the Chart Type dialog box is not on the screen,
click the Chart menu and choose Chart Type.

2. On the left in the Chart type box, click Dough nut.

Notice that there are only two
subtypes. The first is the standard
Doughnut chart. The second is the
same thing except with exploded
slices.

3. With the first sup-type selected, click
OK.

Notice the chart. 

4. Point to each circle and notice that a screen tip
falls down. You can do this on all chart types. The
ScreenTips identify the data series.

XY (Scatter)
Charts

Scatter charts allow you to examine possible relationships between
different sets of data. Although similar to line charts, there are
some subtle differences. For example, an XY (Scatter) chart can use
only values on its X-axis, whereas a line chart can use either values
or labels for its X-axis.

Another difference is that line charts ignore the actual numeric
values and treat them like labels when laying out the chart. For
example, if the X-axis values are 10, 20, and 50, they will be evenly
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spaced along the X-axis. In an XY (Scatter) chart, the actual numeric 
values are considered when laying out the chart. In this same
example, 10 and 20 would be close together on the left and 50
would be farther to the right on the X-axis.

You are going to explore the differences between a line chart and
an XY scatter chart.

1. Open Age vs. In come.

Take a look at the data and notice the column of
ages and the corresponding column of incomes. The
Age column will be the X-axis and the Income
column will be the data points.

2. Click the Chart1 sheet tab.

Notice the line chart. The ages on the X-axis are
evenly distributed, regardless of their numeric
value. These numbers are being treated as labels.
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3. You are going to change this chart to an XY (Scatter)
chart.

On the Chart menu, choose Chart type.

4. In the Chart type box, choose XY 
(Scat ter).

Notice the subtypes.

5. Choose the fourth subtype.

6. Click OK.

Notice the XY (Scatter) chart.
The X-axis now consists of
values in increments of 10.
Because the data points are
proportionately spaced, the chart reflects the
relationship between age and income more
accurately.

Lesson 16 - Creating Charts 225



Other
Subtypes

There are seven other types in the Chart type box. Some of them are
quite specialized charts. 

1. Return to Sales Chart 1.

2. Click the Chart2 tab, if nec es sary.

3. Click the Chart menu, and choose Chart Type.

Following is a brief explanation of each of the items
in the Chart type box that have not been covered.
Spend some time exploring their subtypes in the
same way you have been doing with other subtypes.

! Radar charts are specialized charts and are not
suitable for the data being used. They are used
with applications involving decision analysis.

! Surface charts are similar in appearance to
topographical maps. You can see the value for a
particular data point by its elevation. The
elevations are colored accordingly. “Peaks” and
“valley” in an elevation indicate the location of
data points.

! Bubble charts are similar to XY charts. They
compare sets of three values. The third value
determines the size of the bubbles.

! Stock charts are “Hi-Lo” charts that are used in
cases such as stock quotations. They make it
easy to see both the highest and lowest data
point and those in between.

! Cylinder, Cone, and Pyramid charts are variations 
on column and bar charts.

Custom Types You are not limited to the standard chart types you have seen up to
now. Excel also provides a variety of custom types. In addition, you
can create your own custom types. You are going to explore Excel’s 
custom types. In a later lessons you will create your own.

1. With Sales Chart 2 on the screen, click the Chart
menu and choose Chart type.

2. Click the Custom Types tab.

3. At the bottom of the dialog box is a User-defined
option for chart types that you create and a Built-in
option for those that come with Excel.
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Verify that Built-in is se lected.

In the Chart type box, notice the list of custom chart
types.

4. Choose Blue Pie.

Notice the example in the preview box.

5. Click OK to get a better look.

6. Return to the Chart Type dialog box by choosing
Chart Type on the Chart menu.

7. In the Chart type box, choose Col ored Lines.

Notice the example in the preview box.

8. Click OK to get a better look.

9. Return to the Chart Type dialog box by choosing
Chart Type on the Chart menu.

10. You are going to see a combination chart that combines
both column and line types. You will learn more about
combination charts in the Intermediate course.

Scroll down and choose Line - Col umn.

Notice that the Carlson data series is represented by
a line. The others are represented by columns.

11. Explore some of the other custom charts.
Remember that you will be creating your own
custom types in later lessons.

12. When finished, return to the Chart2 sheet.

The Chart
Toolbar

The Chart toolbar appears automatically when a chart sheet is
active or when a chart is selected. It can also be displayed by
clicking the View menu, pointing to Toolbars and then choosing
Chart on the submenu. You can hide it by doing the same thing or
by clicking its Close button (X). As with all toolbars, its buttons are
merely alternative ways of choosing menu commands.

1. The Chart toolbar might be "docked" at the right of
the Standard or Formatting toolbars. If it is, point
to the vertical dots on the left side of it until a
four-headed arrow appears, and drag it onto the
worksheet.
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2. Click the down arrow next to the Chart Type
drop-down list button.

Notice the types available.

3. Click on a type and watch it applied to the chart.

Notice that the button takes on the current type. If
you wanted to apply this type to another chart, you
would only have to click the Chart Type button.

4. Choose a few more chart types on the Chart Type
down-down list.

In later lessons you will be using other buttons on
the Chart toolbar.

5. When finished, close Sales Chart 1 and Age vs.
In come. There is no need to save changes.

Exercise:
Creating a
Chart

You are going to use the data in the District Sales workbook to
review the steps for creating a chart.

1. Open Dis trict Sales 1.

2. Select the appropriate range in order to create a
column chart comparing the sales for each region
over the 3-year period.

Note: Be sure not to in clude the To tal Sales fig ures.

3. Tap the CREATE CHART key (F11) to create the
default chart type on a new worksheet.

4. Compare and contrast other chart types by using
the Chart Type com mand.

End of Lesson 16
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